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What’s New
The following section describes the new administration, collaboration, and 
development features.

Administration Features
The most extensive changes in Oracle 9iFS lie in its new administrative 
framework. Oracle 9iFS expands its administrative abilities by integrating 
with and taking advantage of new capabilities in Oracle9i Enterprise 
Manager. 

New Protocol and AgentFramework To use these new administrative features, 
Oracle 9iFS now has a significantly modified protocol server and agent 
infrastructure. In this new framework, you can monitor multiple instances 
of Oracle 9iFS, including protocol servers and agents, from a single Oracle9i 
Enterprise Manager Console. When you install and configure Oracle 9iFS, 
you define a domain controller and the nodes within that domain, all of 
which you can administer from the Oracle9i Enterprise Manager Console.

For a complete overview of this new framework, refer to the Oracle Internet 
File System Setup and Administration Guide.

Dashboard Interface The Oracle9i Enterprise Manager Console interface for 
Oracle 9iFS now includes several “dashboard” graphs to display system 
status for all nodes. For example, the dashboard displays the number of 
users connected via each protocol server.

Import/Export Utility The Import/Export utility lets you export all of the 
content and associated metadata from one portion of an Oracle 9iFS 
directory structure. You can then use the exported file to re-create the 
content and metadata on either the original Oracle 9iFS instance or a new 
instance. 

Scalability, Performance, and Reliability Improvements in scalability make it 
easier to both expand the size of the document store as well as increase the 
number of concurrent and named users who can connect to Oracle 9iFS. 
Oracle 9iFS has been tested with 10,000 concurrent users. Oracle 9iFS e-mail 
delivery performance and executing commands using the Oracle 9iFS 
IMAP server have improved. You can now run multiple WCP instances as 
you would any Oracle 9iFS protocol server. 

The performance of content queries and folder-restricted queries has 
improved. 

Lower Memory Usage The memory usage of Oracle 9iFS for large numbers of 
concurrent users has been reduced. The memory overhead for running 
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Oracle 9iFS protocol servers can be lowered by running multiple protocol 
servers in a single Java Virtual Machine (JVM) when there are fewer 
concurrent users. 

For more information, refer to the Oracle Internet File System Setup and 
Administration Guide.

Collaboration Features

Java Web Server no Longer Supported As of this release of Oracle 9iFS, Oracle 
HTTP Server powered by Apache has replaced Java Web Server (JWS) as 
the preferred web server. JWS is no longer supported.

NFS Protocol Server You can now access content in Oracle 9iFS through an 
NFS protocol server. 

File Sync Utility A new utility in Oracle 9iFS synchronizes files between 
your local Microsoft Windows drive and Oracle 9iFS. This utility will 
benefit users who regularly access and edit files on a Oracle 9iFS instance.

For information on installing the File Sync utility, refer to the Oracle Internet 
File System Installation Guide. 

Arbitrary Metadata (categories) for Any File or Folder Oracle 9iFS lets you define 
arbitrary metadata, called categories, that you can apply to any file or 
folder. Previously, extended attributes were based on the type of file. For 
example, the ReadyForPublication property could be added to all HTML 
files. Now, with categories, you can define one set of related attributes and 
then apply them to any file or folder. For example, you could define a 
category that describes all the information needed in a review 
process—NextReviewer, ReadyForPublication, and so forth—and then apply 
them to HTML, GIF, JPG, AVI, or any other files that form your web site. 

For more information on how to use this feature as a user, refer to the online 
help file accessed through any Oracle 9iFS Windows Utilities dialog. For 
more information on how to browse, create, and modify categories through 
the administration interfaces, refer to the Oracle Internet File System Setup 
and Administration Guide.

Multimedia Metadata Extracted Automatically With Oracle interMedia 
Annotator, Oracle 9iFS now automatically extracts color depth, play length, 
closed caption text, and other types of information encoded in audio, video, 
and image files, and then makes this information into searchable and 
editable attributes of these files. One use of this new type of category 
information is extracting metadata encoded in multimedia files to populate 
new Oracle 9iFS file attributes. 
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When upgrading to Oracle 9iFS, the audio, video, and image files created 
using release 1.x of Oracle Internet File System are not annotated. If 
annotation is desired, make sure the Oracle interMedia Annotator Agent is 
running and reload those files back into Oracle 9iFS.

This feature requires the administrator to enable the Oracle Text option for 
Oracle 9iFS. For more information on enabling Oracle interMedia on an 
Oracle 9iFS instance, refer to the Oracle Internet File System Setup and 
Administration Guide. 

Oracle 9iFS Portlet Oracle 9iFS includes a portlet which you can register 
with your Oracle Portal. The portlet allows shortcuts to commonly used 
folders, files and simple searches.

Improvements to Oracle 9iFS Windows Utilities Significant improvements have 
been made to the Oracle 9iFS Windows Utilities. 

■ The software now automatically detects whether the Oracle 9iFS server 
to which the user is connected has a newer version of the software, and 
assists the user in installing it. 

■ Broader support for multi-select operations, such as the ability to apply 
an Access Control List to a group of files or to a folder and its 
subfolders and files. User can Check In, Check Out, Cancel Check Out, 
Lock, Unlock, and Create Link on multiple items. Users may also delete 
and rename versioned documents.

■ The Find utility on Oracle 9iFS is more usable and capable. Users can 
search on the following:

■ custom attributes of documents and their subclasses

■ categories and their subclasses which are associated with 
documents

■  language of the document specified by the user or the default 
specified by the server

■ all versions of a document

The Find utility is now faster due to incremental retrieval of search 
results and faster server-side “folder-restricted” searching.  Users can 
also stop a search when it has only returned some of the results.

■ The Properties dialog has an easier user interface. Users can now edit 
custom attributes, associate categories and category attributes with 
documents and folders, and see all the linked locations of a particular 
document or folder. The Security tab has been updated with a new 
Access Control List and Access Control Entry set of dialog windows. 
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Also, there is improved performance in the way the Utilities interact 
with the SMB protocol. 

Development Features

Expanded and Improved Documentation The Oracle Internet File System 
Developer Reference has been completely rewritten. This reference contains 
new, expanded information covering all aspects of Oracle 9iFS 
development. 

New Sample Code Oracle 9iFS includes a broad range of sample code, both 
within the Oracle Internet File System Developer Reference and installed with 
the product. 

For a complete list of sample code, refer to the Oracle Internet File System 
Developer Reference.

Perform PL/ SQL Procedures in Oracle 9iFS Database Transaction Developers can 
now access the same database transaction that Oracle 9iFS uses when 
committing changes to the relational data store. This feature is critical if you 
want to do any relational database work at the same time that a file system 
operation occurs. For example, if you want to perform a PL/SQL call in 
Oracle Portal when you insert new files in Oracle 9iFS, you can use the 
Oracle 9iFS transaction context for this combined operation.

New Options for Arbitrary Metadata A new type of arbitrary metadata 
interface, categories, is exposed to users within the Oracle 9iFS Software 
Development Kit (SDK), to allow you to programmatically create, edit, 
apply, and search categories.

New E-mail Object and API The Oracle 9iFS SDK component for e-mail has 
changed. Previously, an e-mail consisted of several separate objects that you 
needed to access and manipulate for any e-mail processing. Now, an e-mail 
is a single object. In addition, you can use the Java mail API instead of 
Oracle 9iFS-specific interfaces to generate and process e-mails.

XML Namespace The XML parser installed with Oracle 9iFS recognizes the 
Oracle 9iFS namespace you define within a document. This makes it 
possible for you to avoid conflicts in document definitions and attribute 
names between XML files used to configure Oracle 9iFS and an XML file 
that you might want to store. For example, the CONTENT tag used in many 
XML files no longer conflicts with Oracle 9iFS content objects when the 
Oracle 9iFS-specific files use the new namespace feature.

Round-trip XML Round-trip XML makes it possible to preserve all 
comments and unrecognized elements within an XML file. You can 
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configure Oracle 9iFS to preserve unparsed contents that were previously 
discarded, making it possible to fully re-create an original XML file. This 
feature also allows you to remove elements that appeared in the rendered 
XML file but were not in the original file such as Oracle 9iFS attributes 
added to the rendered XML content.

Custom XML Rendering It is now possible to select a subset of elements to be 
rendered from the database to the browser. By default, only the extended 
elements specific to that Oracle 9iFS class will be rendered. You can choose 
to either add other elements from its superclasses or omit those extended 
elements for rendering purposes.

Client Certifications
The following client software versions have been tested and certified for use 
with Oracle 9iFS:

■ Microsoft Windows Web browsers for FTP, IMAP4, SMTP, HTTP, and 
the Web interface:

■ Netscape Communicator 4.7x release and higher. 

■ Microsoft Internet Explorer 5.0 and higher with Outlook Express 

■ Windows Client Operating Systems for access with SMB and the 
Windows Utilities, as well as the Web interface:

■ Microsoft Windows NT 4.0 Workstation or Server, Service Pack 6, 
and higher 

■ Microsoft Windows 95, 98, and ME

■ Microsoft Windows 2000 Professional and Server

■ Macintosh Web Browsers for the Web interface:

■ Netscape Communicator 4.7x release. 

■ Macintosh Client Operating Systems (for SMB access with Thursby 
Software’s DAVE 2.5.1 support and the Web interface):

■ Apple Macintosh PowerPC OS 9.0.4 and 9.1.

■ NFS Access: 

■ Sun Solaris 2.7, 2.8 client

■ Red Hat Linux 6.1 NFS client

■ Hummingbird NFS Maestro 6.0 for Windows 95, 98, NT

■ Hummingbird NFS Maestro 7.0 for Windows NT and 2000

■ OnNet 7.0
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■ FTP Access: 

■ OnNet FTP 4.0

■ Eudora 4.3 for IMAP, SMTP

■ PINE 4.2 for IMAP, SMTP

System Patches
Patches 1957857 and 1971104 must be installed prior to Oracle 9iFS 
installation. These patches are included on the CD-ROM, and are located in 
the patch directory. 

Hardware Requirements
The following sections describe the minimum and recommended hardware 
configurations for Oracle 9iFS.

Minimum Configuration
The following configuration numbers are for two-tier configuration and for 
running all protocol servers. This configuration will support approximately 
two users, accessing approximately two protocols concurrently.

■ 512 MB of RAM and 1 GB of swap space

■ 5 GB of disk space (4.5 GB for the database, 0.5 GB for Oracle 9iFS)

Recommended Configuration
If you plan to run the database and Oracle 9iFS on the same machine, then 
the following configuration will support approximately 50 users, accessing 
each protocol moderately. This does not include running the Oracle9i 
Enterprise Manager Console, which takes additional resources.  

■ 1 GB of RAM and 2 GB of swap space

■ 5 GB of disk space (4.5 GB for the database, 500 MB for Oracle 9iFS)

If you plan to have more than 50 users connecting to your Oracle 9iFS 
server, you should install the Oracle9i database and Oracle 9iFS on separate 
machines.

Note: If you do not plan on running the Oracle9i Enterprise 
Manager Console and all Oracle 9iFS protocol servers 
simultaneously, you may be able to run Oracle 9iFS on the 
same machine as the Oracle9i database with less than 512 MB 
of RAM
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Deprecations and Changes in the Oracle 9iFS Java API 
As the Oracle 9iFS Java API expands to take advantage of new features and 
technology, certain classes, fields, and methods may be deprecated. 
Customers should expect that these deprecations will be deleted in the 
following major release. This allows our customers a full release cycle to 
modify their applications to use the supported classes, fields, and methods.

To see what is deprecated in this release, go to the “Deprecated” link in the 
Javadoc. Each deprecation has a comment indicating the equivalent 
supported usage. You can also check if your application is using any 
deprecated classes, fields, or methods by compiling your Java application 
with the -deprecation flag.

Collections Improvements
In this release, the Oracle 9iFS implementation of 
java.util.Collections has changed to improve scalability. Notable 
changes include the following:

■ Not all items in a collection are cached.

■ Collection was modified from a class to an interface.

■ The methods of the new Collection interface have the same signatures 
as the methods of the old Collection class.

New Implementation Classes. The following classes implement Collection:

oracle.ifs.common.Collection (interface)
|
+---oracle.ifs.common.CachedCollection (abstract)
| |
| +--- oracle.ifs.common.CachedSelectorCollection
| |
| +--- oracle.ifs.common.CachedResolverCollection
|
+---oracle.ifs.common.UncachedResolverCollection

The declared return values of the get*Collection() methods of 
LibrarySession and S_LibrarySession are changed to reflect the appropriate 
Collection subclass.

Error Codes The error codes of the methods in Collection have been 
modified. If a specified name is invalid, the exception stack thrown by 
Collection.getItems(String)is as follows:

iFS 1.1:
IFS-12200 ("Invalid item name specified")
IFS-12214 ("Unable to get item in collection by name")
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IFS-12200 ("Invalid item name specified")

As an example of this modification to the error codes in Collection, consider 
an error code such as this:

if (e.getErrorCode() == 12200)

For this release, the error code should be changed as follows:

if (e.containsErrorCode(12200))

In general, it is a better practice to use containsErrorCode() when 
expecting a specific error. In this manner, your code is protected should the 
error code ever change in the exception stack it occurs. 

For more information these classes, refer to the Javadoc.

General Issues

Oracle Text Indexing of Oracle 9iFS Documents
Administrators may view which documents generated errors when they 
were indexed by Oracle Text by examining the example 
$ORACLE_HOME/9ifs/admin/sql/ViewContextErrors.sql. 

If administrators want to monitor each document as it is indexed by Oracle 
Text, they can use the procedure ctx_output.add_event()prior to 
synchronizing the Oracle Text index. See the example 
$ORACLE_HOME/9ifs/admin/sql/SyncContextIndex.sql. For an 
example of viewing more information about the documents that have just 
been indexed by Oracle Text, see 
$ORACLE_HOME/9ifs/admin/sql/ViewDocumentByRowID.sql.

For more information about using Oracle Text to index Oracle 9iFS 
documents, refer to the Oracle Internet File System Setup and Administration 
Guide. 

New Search Timeout Parameter
A new service configuration parameter has been introduced that indicates 
the default timeout period for any executing search that has not yet 
returned results. In the default service configurations, the 
IFS.SERVICE.SESSION.DefaultSearchTimeoutPeriod parameter 
has the value of 60 seconds. 

If a different default timeout period is desired, then the 
IFS.SERVICE.SESSION.DefaultSearchTimeoutPeriod parameter 
can be changed. 
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For more information on the timeout parameter, refer to the Oracle Internet 
File System Setup and Administration Guide. 

Administrators Must Run analyze Script on their Oracle Database
Because Oracle 9iFS uses advanced features of the Oracle database, Oracle 
9iFS requires use of Oracle’s Cost-Based Optimizer (CBO) to determine the 
most efficient way to execute SQL statements. For CBO to work properly, 
the administrator should run the analyze script before using Oracle 9iFS. 
This script should be run regularly during use of Oracle 9iFS, especially 
after users have loaded a large number of files into Oracle 9iFS or have 
changed their data in other ways.

On AIX-Based Systems (64-bit), enter the following commands:

cd $ORACLE_HOME/9ifs/admin/sql
sqlplus ifssys/password @analyze.sql ifssys

In the preceding command, ifssys is the Oracle 9iFS schema name.

Note that the script may take several minutes to complete, especially when 
there are a large number of documents in Oracle 9iFS. In general, the script 
should be run during periods of reduced load on the system. 

For more information about the Cost-Based Optimizer, refer to the Oracle 
Performance Guide. 

Oracle 9iFS User Names May Not Contain Multi-byte Characters
Oracle 9iFS restricts the use of multi-byte user names. Access through 
WebDAV (Web Folders and Oracle 9iFS File Sync), HTTP (Oracle 9iFS Web 
interface or Web browsers), SMB (for Windows 95/98) and IMAP (e-mail) is 
not available for user names that contain multi-byte characters.

Protocol-specific Issues

Web Access 
To access Oracle 9iFS through HTTP, use a URL in this format:

http://server-name:port number/ifs/files

By default, the port number is 7777. An example of the URL would be as 
follows:

http://myserver.mycompany.com:7777/ifs/files

In the preceding example, myserver.mycompany.com is the server name, and 
7777 is the port number. 
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This URL is required for the following:

■ Access through a web browser to the Web interface, or to retrieve files 
directly through HTTP.

■ Access through WebDAV applications such as Web Folders.

■ Access to Oracle 9iFS using the File Sync feature.

NFS Protocol Support
Oracle 9iFS includes an NFS server.  For more information on configuring 
the Oracle 9iFS NFS server, NFS clients, and mapping UNIX users to Oracle 
9iFS accounts, refer to the Oracle Internet File System Installation Guide.

AIX does not currently support the public file handle lookup protocol 
(Internet RFC 2045 - WebNFS Client Specification). Therefore, to enable AIX 
4.3.3 clients to mount the directories exported by iFS, you must run the iFS 
Protocol Server for NFS using the default NFS port 2049.

Oracle 9iFS NFS Server Limitations. The Oracle 9iFS NFS server has the 
following limitations:

■ Permission mode bits do not determine access 

The Oracle 9iFS NFS server returns the permission mode bits as read, 
write, and execute permissions for the document owner, the current 
user, and public access. Actual access to the document, however, is 
controlled by the Oracle 9iFS Access Control List (ACL). The mode bits 
returned by the Oracle 9iFS NFS server may not reflect the actual access 
available to a user.

■ You cannot change owner, group, or mode using  UNIX commands. 

The owner, group, and mode for a document in the Oracle 9iFS NFS 
server cannot be changed using the UNIX chown, chgrp, or chmod 
commands. These commands will appear to succeed, but will not 
actually modify the attributes of the document.

■ The Oracle 9iFS NFS server does not allow access to the checked-out 
version of a versioned document.

The Oracle 9iFS NFS server does not allow access to the checked-out 
version of a versioned document because this would violate the caching 
algorithm used by NFS clients. This algorithm assumes that the 
contents of a file are the same for all users. Allowing access to the 
checked-out version of a document would violate this assumption 
because the user who checked out the document would see different 
document contents from other users.

■ A versioned document cannot be deleted, moved, or renamed.
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Microsoft Office applications and other programs save files by first 
saving the data to a temporary file, deleting the original file, and then 
renaming the temporary file to the original name. In the case of 
versioned documents, this would result in the loss of all previous 
versions, so versioned documents are not allowed to be deleted, 
moved, or renamed.

■ Handles returned by the Oracle 9iFS NFS server are incompatible with 
the UNIX lock manager (NLM).

Programs that require the UNIX lock manager will not work with the 
Oracle 9iFS NFS server, because of an incompatibility between the 
Oracle 9iFS NFS server and NLM.

■ UNIX hard and symbolic links are not supported (Issue 1749778)

UNIX-style links are not compatible with Oracle 9iFS. Oracle 9iFS links 
may be used instead.

Oracle 9iFS File Sync Utility Limitations The File Sync utility is able to detect 
changes made by you on your local machine and by you or others on 
Oracle 9iFS and, generally, is able to resolve any conflict in these changes. 
However, certain types of changes may conflict and cannot currently be 
resolved by File Sync. In these cases, File Sync only gives you the option to 
skip synchronizing these file changes.

The following types of conflicts are currently not resolvable. In the 
following, the source file is the original file, and the target file is the 
resulting file.

■ NEW/DELETE: when the target of NEW conflicts with the source of 
DELETE. For example, a local folder and an Oracle 9iFS folder are 
synchronized, and a user creates a new file in the local folder, but the 
folder on Oracle 9iFS is deleted. This conflict is not currently resolvable.

■ NEW/COPY: when the target of NEW conflicts with the source or the 
target of COPY.

■ NEW/EDIT: when the target of NEW conflicts with the target of EDIT.

■ NEW/MOVE: when the target of NEW conflicts with the source or the 
target of MOVE).

■ MOVE/EDIT: when the target of EDIT conflicts with the source or the 
target of MOVE. 

■ MOVE/DELETE: when the source of DELETE conflicts with the source 
or the target of MOVE.

■ MOVE/MOVE: when both the source and the target of both MOVEs 
cause possible conflict.
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■ COPY/COPY (when both source and target of both COPY procedures 
cause a possible conflict). 

■ COPY/DELETE: when the source of DELETE conflicts with the source 
or the target of COPY.

■ COPY/EDIT: when the target of EDIT conflicts with the source or the 
target of COPY.

■ COPY/MOVE: when both the source and the target of COPY and 
MOVE cause a possible conflict.

Web Interface and Uploading Using the  Drag-and-drop  Function in Multi-byte 
Locales
Due to a bug with Internet Explorer running in multi-byte environments, 
upload using the drag-and-drop function will work only when the default 
character set for the Oracle 9iFS server matches the character set of the 
client machines. 

Web Proxies for FTP Drag-and-drop Function
Users may need to edit their web browser preferences to not use a proxy for 
FTP. Using a web proxy may cause problems when using the drag-and-drop 
function in the Web interface to upload files to the server.

Known Bugs
The following bugs are known to exist in this Oracle 9iFS release. 
Workarounds are given when appropriate. The known bugs are grouped by 
process or component: 

■ Installation Bugs
■ Generic Oracle 9iFS Bugs
■ XML Bugs
■ Windows and SMB Bugs
■ Windows Utilities Bugs
■ Web Interface Bugs
■ FTP Bugs
■ E-mail Bugs
■ HTTP Bugs
■ Oracle 9iFS Manager Bugs

Installation Bugs
The following table describes the known installation bugs and provides 
workarounds when appropriate. 
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Bug Number Description and Workaround

Bug 1865469 When you de-install Oracle 9iFS software and then reinstall 
it in the same Oracle home directory using the same Oracle 
9iFS schema, the Intelligent Agent will be unable to discover 
the Oracle 9iFS domain controller and node that existed in 
the schema previously.

Workaround: Before de-installing, make a backup copy of 
ORACLE_HOME/network/agent/config/ifs.ora. 
After re-installing the Oracle 9iFS software, run the Oracle 
9iFS Configuration Assistant, and choose to re-use the same 
schema. Next,  restore the backup copy of ifs.ora so that 
the Intelligent Agent will be able to discover the Oracle 9iFS 
domain controller and nodes. 

Bug 1852624 If the Oracle 9iFS Configuration Assistant schema upgrade 
fails, a subsequent upgrade of the same schema may not 
enable Oracle Text. 

Workaround: Manually enable Oracle Text using the scripts 
to create the Context index provided in ORACLE_
HOME/9ifs/admin/sql. 

Bug 1860278 Oracle 9iFS Configuration Assistant may stop responding 
on "Verifying Oracle JServer" under unusual circumstances.

Workaround: If the step does not complete within two 
minutes, kill the process and re-start the Oracle 9iFS 
Configuration Assistant. 

Bug 1866051 The step of “Checking available ports” when running the 
Oracle 9iFS Configuration Assistant may take several 
minutes if the Apache Web Server or the Oracle 9iFS JServ 
process is running. 

Workaround: Stop the Oracle 9iFS JServ process using the 
following command:

ifsJservctl -stop 

Stop the Apache Web Server using the following command: 

apachectl stop

Wait for the ports to clear, then rerun the Oracle 9iFS 
Configuration Assistant. 
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Generic Oracle 9iFS Bugs
The following table describes the known Oracle 9iFS bugs and provides 
workarounds when appropriate. 

Bug 1529995 When performing an upgrade from Oracle Internet File 
System release 1.x to Oracle 9iFS, the value domain used by 
Oracle 9iFS Manager to manage renderer policies is 
removed and recreated to accommodate new renderer 
policies added for WebDAV and e-mail. Any custom 
renderer policies created and added to this value domain 
will be lost. Note that the policy is not removed since Oracle 
9iFS Manager cannot see the policies. This does not affect 
any of the standard renderer policies. 

Workaround: Note the custom renderer policies added into 
the value domain. After you install Oracle 9iFS, add these 
entries back into the value domain, for example, through 
the Oracle 9iFS Manager.

Bug Number Description and Workaround

Bug 1857689 Conflicting custom classes must be deleted and re-created 
with new names that do not conflict prior to upgrading. The 
new classes added to Oracle 9iFS are: 

■ interMediaAudio 
■ interMediaAudioCdTrack 
■ interMediaImage 
■ interMediaMovie 
■ interMediaSource 
■ interMediaVideo 
■ MediaTextBlob 
■ NodeConfiguration 
■ PortletUserProfile 
■ Rfc822ContentObject 
■ Rfc822Message 
■ ServerConfiguration 
■ ServiceConfiguration 

Bugs 1837169, 
1840606

Content indexing of PDF documents through Oracle Text is 
slower in the Oracle 8.1.7.2 and Oracle9i database, release 1 
than it was in Oracle 8.1.7.0.0 database. 

Workaround: Ensure that sufficient CPU capacity is 
available on the machine running the Oracle database. Two 
CPUs or more is recommended. 
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XML Bugs
The following table describes the known XML bug and provides a 
workaround for it.

Bug 1736391 The Oracle interMedia Annotator will attempt to parse 
International Press Telecommunications Council (IPTC) 
metadata in JPEG files when none is actually present. This 
results in an exception in the log files. Since Oracle 9iFS 
does not take advantage of IPTC information even when it’s 
present, you may want to disable IPTC parsing. 

Workaround: Stop the interMedia Annotator agent. 

Edit $ORACLE_HOME/ord/Annotator/lib/ 
descriptors/parsers/JpgParser.xml and change 
the line:

<ParameterValue> true </ParameterValue>

to 

<ParameterValue> false </ParameterValue>

Restart the interMedia Annotator agent. Any JPG files that 
previously failed to be annotated due to this issue will be 
reparsed. 

Bug 1724775 Content-based searches "OR-ed" with criteria that should 
also return non-indexed files will only return indexed files. 
For example, a content-based search, such as “all files 
containing 'Oracle' "OR-ed" with an attribute search fails to 
return the non-indexed files in the search result. 

Workaround: Break the search into two searches:  a content 
search and a attribute search. 

Bug 1833065 Each time the interMedia Annotator fails to annotate a file, 
node log file may have stack traces with exceptions 
IFS-45371 and IFS-46402. These two exceptions are logged, 
and the stack trace is dumped to the log. 

Workaround: None. 

Bug 1855983 In a multi-byte Oracle Text-enabled installation, 
multi-media files (audio, video and images) are 
automatically annotated by the interMedia Annotator agent. 
For some installations, the interMedia Annotator puts 
invalid characters in as the category metadata. 

Workaround: Change the environment variable LANG to 
match the native language (for example, Korean should be  
set to LANG=ko), and restart Oracle 9iFS. 

Bug Number Description and Workaround
 16



Windows and SMB Bugs
The following table describes the known Windows and SMB bugs and 
provides workarounds when appropriate.

Bug 1600470 By default, creating a user through XML will create the 
e-mail address by concatenating the Username and the 
EmailAddressSuffix. If the username contains multi-byte 
characters, then the user creation fails because an e-mail 
address cannot contain multi-byte characters.

Workaround: Explicitly set the e-mail address without 
multi-byte characters using the EmailAddress tag.

Bug Number Description and Workaround

Bug 1791830 On Windows NT and 2000 systems, double-clicking on a 
Microsoft Office file, such as *.doc, and *.xls,  with a high 
ASCII character in the filename (characters which are not 
7-bit USASCII)  causes the error “The file could not be 
found”. 

Workaround: Launch the Microsoft Office application and 
then use  File > Open to open the file. 

Bug 809516 When using the MS-DOS command shell on Windows 95 
and Windows 98 systems, file names are not displayed for 
files on the Oracle 9iFS server.

Workaround: Use the Windows Explorer and Desktop for 
all file operations on Windows 95 and Windows 98 systems.

Bug 1113581 Attempts to delete or rename a versioned file in SMB result 
in a failure message indicating that all or part of the file may 
be locked. Certain applications, such as Microsoft Word and 
Microsoft Excel, save the files by deleting old versions of the 
document. This would cause a loss of data attributes and 
compromise the versioning features of Oracle 9iFS. The 
Oracle 9iFS SMB server does not allow deletion or renaming 
of versioned files.

Workaround: Through Windows Explorer, right click on the 
versioned document and use the “Delete Versioned 
Document” capability of Oracle 9iFS Windows Utilities or 
use the Web interface.
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Bug 1115154 Attempts to save a versioned document result in an error 
message indicating that all or part of the file may be locked.

This error appears for one of two reasons:

■ Files associated with certain applications, such as 
Microsoft Word and Microsoft Excel, cannot be edited 
in place in Oracle 9iFS. These applications delete 
previous versions of the document as part of the save 
process.

Solution: When working with files that produce such 
errors, try saving the file to a local directory and then 
copying it on top of the Oracle 9iFS versioned file.

■ A versioned file cannot be edited before first being 
checked out by the user.

Solution: To edit a versioned file,  check it out.

Bug 1243158 Locking a folder in Oracle 9iFS will prevent all users from 
renaming and deleting a folder. Locking a folder will also 
prevent items from being added or removed from that 
folder. Because this extra functionality is not designed into 
Windows and current Windows applications, locking an 
Oracle 9iFS folder through setting the Windows read-only 
attribute is not permitted.

Workaround: To prevent users from changing the contents 
of a folder, lock it through another interface, such as the 
Web interface. This will prevent Windows users from 
adding or removing files from the folder; however, this 
technique will not prevent the users from modifying the 
files in the folder unless those files are also locked.

Bug 1254675 After saving a file through SMB there may be a delay of up 
to a minute before those changes are visible to other users 
and other protocols. This is caused by local caching by the 
Windows operating system which benefits Windows 
performance.

Workaround: The changes are shown immediately if the 
user refreshes the directory listing from the Windows 
Explorer.

Bug 1364155 Saving a Microsoft Word 95 file on some Windows 95 client 
machines results in an error that the file is in use.

Workaround: 

1. Use the Save As command to save the file with a differ-
ent name.

2. Open the locked file and replace the old contents with 
the new contents using cut and paste.

3. Save the original file with the new contents.
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Windows Utilities Bugs
The following table describes the known Windows Utilities bugs and 
provides workarounds when appropriate.

Bug 1374563 Attempting to open a versioned Microsoft Excel file (*.xls) 
that is not checked out causes a Microsoft Excel error 
message indicating that the document is being modified by 
another user when using SMB. The file can be opened in 
read-only mode.

Workaround: The document is not being modified by 
another user, but since the document is not checked out it is 
locked and cannot be written to. Confirm opening the file in 
read-only mode or check it out.

Bug 1401439 After extracting a large number of files using WinZip, the 
user may be unable to read or write any more files from the 
mapped drive. The user may get an error similar to “Too 
many files are currently in use. Quit one or more programs, 
and then try again.” or an error that a file could not be 
opened.

Workaround: The user can unmap and re-map the network 
drive. The administrator can also increase the default 
maximum number of open files per mountpoint for the SMB 
server using the following parameters:

MaxOpenFiles = 30
MaxAllOpenFiles = 100

Increase them as necessary until the problem is resolved.

Bug 1622123 All system administrators have the Private ACL as their 
default ACL. This means when an administrator populates 
Oracle 9iFS using the drag-and-drop function in SMB, all 
folders and files will have the Private ACL. No other users, 
except system administrators, will be able to access the 
folders or files.

Workaround: Load the files as a non-system administrator. 
These users have Published as their default ACL.

Bug Number Description and Workaround

Bug 1873831 When using the Find function on Oracle 9iFS to find large 
numbers of documents over many queries, the client 
machine may run out of memory.

Workaround: Close the Find function on Oracle 9iFS 
application and start it again. 
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Web Interface Bugs
The following table describes the known Web interface bugs and provides 
workarounds when appropriate.

Bug 1845460 Control characters in file attributes may give an  IFS-1003 
exception. If you see the exception IFS-1003 when the 
Windows Utilities is attempting to display the results of a 
Find, it may be because there is a control character in the file 
attributes.

Workaround: Isolate the problem file and remove control 
characters from the attributes of that file.

Bug 1807421 In the Oracle 9iFS User Profile dialog, the keyboard 
shortcuts stops working for the fields “Old Password” 
(ALT+O) and “New Password” (ALT+N) if there is has been 
any password authentication errors.

Workaround: Use the tab key or the mouse to navigate to 
these fields.

Bug 1728051 Oracle 9iFS Find function using Category may return 
duplicate results if a document is associated with more than 
one category. Those categories have a subclass/superclass 
relationship, and the search on the superclass will result in  
duplicated documents in the result set.

Workaround: Ignore the duplicate documents.

Bug 1416975 In Windows NT, if you use the drag-and-drop function with 
a file that has a file name longer than 256 characters, then 
some of the Windows Utilities will not work. 

Workaround: None. This is a Microsoft Windows limitation. 

Bug Number Description and Workaround

Bug 1831286 Uploading very large documents (for example, over 100 
MB) using Browse in the Web interface can fail. 

Workaround: Use the drag-and-drop function to upload, 
use FTP directly, or another protocol. 

Bug 1859980 When you resize  the browser window on a  Macintosh, you 
may notice that the tree (left) and container (right) frames 
do not reload. 

Workaround: After resizing the window, press the reload 
button. The tree (left frame) will not retain its current state.

Bug 1860905 If you create a folder with high ASCII characters (8-bit 
characters), you cannot create a link to that folder in the 
Oracle 9iFS portlet. 

Workaround: Choose a folder name that does not contain 
high ASCII characters. 
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Bug 1831063 Occasionally stale data in the browser cache will prevent 
you from logging into the Oracle 9iFS Web interface even if 
username and password are correct.

Workaround: Clear the browser’s cache by pressing the Shift 
key and clicking Reload. 

Bug 1842888 In Netscape, squares sometimes appear instead of 
multi-byte characters. When the font names specified in the 
Oracle 9iFS Web interface are not recognized by the 
browser. 

Workaround: Change settings in Netscape to “Use my 
default fonts and override document specified fonts”. 

Bug 1853303 Clicking does not always open the folder in the container 
(right) frame. After opening a folder using the tree (left) 
frame, subsequent clicking on folders in the container 
(right) frame may fail to display their contents. 

Workaround: Use the tree (left) frame to open folders and 
other container objects. 

Bug 1104090 In Netscape, uploading a folder using the drag-and-drop 
function  fails. This is a Netscape browser issue.

Workaround: You have three options:

■ If the folder's contents are not folders, first create the 
folder in Oracle 9iFS, then upload the folder's contents 
using the drag-and-drop function.

■ Upload using Browse rather than the drag-and-drop 
function.

■ Use Internet Explorer.

Bug 1235607 If quotas are being used, and you are currently near or over 
your quota, then you may not be able to upload any files, 
even if you are attempting to replace an existing file.

Workaround: Delete the file you are replacing before 
attempting the upload.

Bug 1244053 After entering a username and password, pressing the Enter 
key causes login screen to beep on the login.jsp.

Workaround: Press the Tab key to select the Login button 
before pressing Enter.

Bug 1248003 After resizing the window, the headings on the File List no 
longer appear. The text is black on a black background. 

Workaround: This is a style sheet and browser issue. Reload 
the File List by clicking the current folder in the Directory 
Tree.
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Bugs 1252587, 
1106093, 1263638

When executing tasks that require a long time to complete, 
such as complex searches, searches over a very large data 
set, or deleting a large folder tree, the connection times out 
and fails.

Workaround: Shut down the service and increase the 
SessionTimeoutPeriod parameter in the properties file 
and restart the service. The default value is 10 minutes.

Bug 1258791 A design issue in the Web interface limits the number of 
items you can have selected when you choose Apply ACL 
from the Edit menu. Cannot apply ACLs to more than 100 
items in the Web interface at one time.

Workaround: Select fewer than 100 items when you are 
applying ACLs.

Bug 1370141 If you set the Windows NT display parameters to use small 
fonts, the menu options in the Upload and 
Check-In/Check-Out menus overlap one another. This 
problem only occurs in Netscape browsers.

Workaround: Change the font settings in the Display section 
of the Windows control panel to use medium or large fonts.

Bug 1372615 Using Internet Explorer 5.0 or 5.5 to upload a file with a 
non-ASCII file name with the drag-and-drop function 
results in an error message that the file already exists. 
Choosing to overwrite the non-existent file causes the 
filename to be truncated when the file is stored in Oracle 
9iFS.

Workaround: This is a known NLS bug with the FTP 
window in Internet Explorer 5.0 or 5.5. Upload using 
Browse, or use a different protocol server to upload the file.

Bug 1374498 Non-ASCII file name is displayed as squares while viewing 
its parents. For a file with a non-ASCII name, if you open 
the View Parents window to see all the folders in which a 
file appears, the file name appears as a series of rectangles.

Workaround: Set your browser to ignore typefaces. For 
example, in Netscape, select Edit > Preferences > 
Appearance and set Fonts option to “Use My Default 
Fonts.”

Bug 1384904, 
1379837, 1374374

Cannot upload a file with non-ASCII characters in filename 
when using the Browse function and Netscape. 

Workaround: Use Internet Explorer or a different protocol to 
upload the file, such as FTP or SMB.

Bug 1387938 The drag-and-drop function from the Web interface to 
upload  may fail if the path to the server is not fully 
qualified when using FTP.

Workaround: Either fully qualify the path to the server (for 
example, http://myserver.mycompany.com:2100) or 
use a different protocol server to upload the file.
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FTP Bugs
The following table describes the known FTP bug and provides a 
workaround.

Bug 1399626 Uploading a file using the drag-and-drop function into a 
folder with a period in its name causes the file to open in 
Internet Explorer instead of being uploaded.

Workaround: Navigate one level up from the folder, then 
back down into the folder will enable the upload to work.

Bug 1399646 If a folder name contains an apostrophe, you cannot open 
that folder in the Web interface.

Workaround: Remove the apostrophe from the folder name.

Bug 1403302 Using theme search in the Advanced Find window causes 
the Web server to stop responding to requests.

Workaround: Do not use theme searches. (Theme indexing 
is turned off by default in Oracle 9iFS.)

Bug 1408308 Users cannot create a link to individual versions of a 
versioned document.

Workaround: If you want to reference a particular version of 
a document, you can paste and create a copy, but you 
cannot have a reference. 

Bug 1416997 The tree frame gives unexpected results if a folder in the 
tree is renamed using a different protocol.

Workaround: Refresh the browser.

Bug 1480275 The File Contents criterion of the Advanced Find window 
allows you to specify a particular string to search on and its 
language. Some users may think they’re specifying a 
language attribute to search on.

Workaround: Use the Windows Utilities instead.

Bug 1524432 Changing the renderer implementation for the WebDAV 
renderer stops the Web interface.

Workaround: Do not subclass Renderer. Create a custom 
renderer.set.

Bug 1604545 Using UTF-8 encoded *.js files causes a Web page error in 
Internet Explorer for Simplified Chinese. This is a known 
issue with some versions of  Internet Explorer.

Workaround: Use only Internet Explorer 5.5 (5.50.4134.0600) 
with Simplified Chinese systems.

Bug 1872138 Folder items are sorted uppercase, then lowercase. When 
listing the items in a folder, the item sort is  case-sensitive, 
by name.

Workaround: None.
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E-mail Bugs
The following table describes the known e-mail bugs and provides 
workarounds when appropriate.

Bug Number Description and Workaround

Bug 1832626 Occasionally the Browser will stop responding when using 
Netscape as the FTP client to upload a file into Oracle 9iFS. 
This occurs when using Netscape as an FTP client and 
during a file upload using the drag-and-drop function 
through the Web interface.

Workaround: Try again or use Internet Explorer as the FTP 
client.

Bug Number Description and Workaround

Bug 1859056 Content searches will not return matches on binary 
attachments in e-mail messages. 

Workaround: None. Currently only text and HTML e-mail 
content and attachments are indexed. 

Bug 1197079 Occasionally, trying to delete several messages and expunge 
them at once using Netscape Messenger 4.7 causes the client 
to fail.

Workaround: Retry the operation. If the error recurs, restart 
the client and delete messages in smaller groups.

Bug 1248657 Mail sent from a machine that uses XFN instead of DNS 
does not always work. XFN is a federated naming service 
used instead of DNS.

Workaround: DNS is required for Oracle 9iFS.

Bug 1379886 It is not possible to remove folders named with non-ASCII 
characters using EUDORA 4.3.2.

Workaround: Use another e-mail client, SMB, or the Web 
interface to remove the folder.

Bug 1380015 If a user name has non-ASCII characters, logging into the 
IMAP server may fail. This happens if the server character 
set is not set correctly.

Workaround: Set the Oracle 9iFS server default character set 
to ISO8859-1 or the appropriate multibyte character set.

Bug 1387952 An e-mail that originated from a PINE client is not viewable 
in the Oracle 9iFS Web interface. The body of the e-mail will 
not be displayed and instead a “404 Document not found” 
error is reported.

Workaround: The e-mail message can be viewed using any 
standard e-mail client suitably configured, and through 
Windows Explorer using Oracle 9iFS SMB.
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HTTP Bugs
The following table describes the known HTTP bug and provides a 
workaround for it.

Oracle 9iFS Manager Bugs
The following table describes the known Oracle 9iFS Manager bugs and 
provides workarounds when appropriate.

Bug Number Description and Workaround

Bug 1393110 In an Apache environment, servlet names exactly matching 
one or more of the first characters of the name of a top-level 
directory will cause the Web interface to fail. For example, if 
the name of the servlet is files, the presence of a folder 
named files will cause the Web interface to fail.

Workaround: Do not create any top-level folder on Oracle 
9iFS with the same first set of characters as the servlet name 
(by default, files).

Bug Number Description and Workaround

Bug 1822898 When using OEM on UNIX, if you do not provide the host 
credentials for the root user when you start or refresh the 
domain (or in the OEM preferred credentials), OEM may list 
only the HTTP node and its related servers, even though 
you selected other servers to run. In addition, the OEM job 
to launch the Oracle 9iFS main node may fail with the 
following output:  “ORACLE_
HOME/9ifs/bin/ifslaunchnode must be run as root. “

Workaround: Provide the UNIX root user credentials when 
launching the main node through OEM or in the OEM 
preferred credentials. 

Bug 1753455 When you use Oracle 9iFS Manager to make a change in the 
protocol or server configuration, you will need to unload 
and reload the servers, not just stop and start the servers, 
before the change will take effect. 

Workaround: Unload and reload the servers after any 
changes. 

Bug 1847573 If you launch the Oracle 9iFS Dashboard from within OEM 
and have incorrect credentials in the OEM preferred 
credentials, the Dashboard will exit without any error 
message. 

Workaround: Set the preferred credentials to be the Oracle 
9iFS schema name and password. Check the 
dashboard.log file in the ORACLE_HOME/9ifs/log 
directory for more information.
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Bug 1857080 When invoking the Oracle 9iFS Dashboard from the 
command line instead of OEM, some messages are 
displayed on the terminal (standard output). 

Workaround: None. These messages may be safely ignored.

Bug 1867608 In the Oracle9i OEM Console, Oracle 9iFS related online 
help appears in its own ’Contents’, ’Index’, and ’Find’ tabs, 
separated from the rest of the OEM online help. 

Workaround: None.

Bug 1522235 When using Oracle 9iFS Manager in Spanish, Italian, Korean 
and Traditional Chinese, some menus, tool-tips and buttons 
may show up in English. 

Workaround: None. 

Bug 1718014 Cannot add extended attributes that are named the same as 
SQL reserved words. You cannot name an attribute with 
Oracle reserved words such as UNIQUE and SELECT. 

Workaround: Choose other names for the attribute. For 
more information and a list of reserved words, refer to  the 
Oracle9i SQL Reference. 

Bug 1683035 On AIX-Based Systems (64-bit),  the Property Inspector does 
not correctly re-size the “Categories” or “Relationships” 
pull-down splitter when using the mouse. As a result, 
categories and relationships can't be seen until the user 
manually clicks and pulls down the splitter. 

Workaround: Before navigating the Properties, Categories, 
or Relationships tabs, click the Properties tab twice, after 
which all splitters will be re-sized correctly. This step must 
be done only once per session. 

Bug 1167418 The ACLs of DirectoryUsers cannot be changed in the 
Oracle 9iFS Manager.

Workaround: Go to the Web interface and select the user in 
the Users list. Click Edit > Apply ACL to update the ACL.

Bug 1388097 Users and ACLs cannot be renamed in Oracle 9iFS 
Manager.

Workaround: To rename an ACL, go to the Web interface, 
select the ACL in the ACL list and click Edit->Rename. 
Renaming a DirectoryUser requires a Java utility that can 
update the NAME attribute of the DirectoryUser.
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